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Today’s program
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Challenges for mobile gfx

Small displays
getting much better
Computation
Speed
power / batteries

thermal barrier

Memory




State-of-the-art in 2001:
GSM world

The world’s most played
electronic game? :

According to The Guardian
(May 2001)

Communicator demo 2001
Remake of a 1994 Amiga demo

<10 year from PC to mobile



State-of-the-art in 2001:
Japan
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High-level API with skinning, flat shading /
texturing, orthographic view



State-of-the-art in 2002:
GSM world

3410 shipped in May 2002

A SW engine: a subset of OpenGL
iIncluding full perspective (even textures)

3D screensavers (artist created content)

FlyText screensaver (end-user content)

a 3D game NokiA || NOKIA




State-of-the-art in 2002:
Japan

Gouraud shading,
semi-transparency,
environment maps




State-of-the-art in 2003:
GSM world

N-Gage ships

Lots of proprietary 3D engines
on various Series 60 phones

Fathammers | W
Geopod A
on XForge




State-of-the-art in 2003:
Japan

Perspective view,
low-level API
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Mobile 3D in 2004

6630 shipped late 2004

First device to have both
OpenGL ES 1.0 (for C++) and
M3G (a.k.a JSR-184, for Java) APIs

Sharp V602SH in May 2004

OpenGL ES 1.0 capable HW
but API not exposed

Java / MascotCapsule API




2005 and beyond: HW




Mobile 3D APIs

Java Applications
Native C/C++
Applications
M3G (JSR-184) Java Ul API

Graphics Hardware | Operating System (Symbian, Linux, ...)




Overview: OpenGL ES ﬁ

Background: OpenGL & OpenGL ES
OpenGL ES 1.0

OpenGL ES 1.1

EGL: the glue between OS and OpenGL ES

How can | get it and learn more?




What is OpenGL?

The most widely adopted graphics standard
most OS’s, thousands of applications

Map the graphics process into a pipeline

modeling
IMAGING PATH 4
m—l—r-_ Unpack Pizels —I~. Piesd Operations _,_i_ Im.igqa- Rasterization | CIlpﬁlng
lighting & shading
| | 3
Display Lints - -l Taxeure Memory I' - - Er;mrﬂﬂi’:tm b TO FRAME BUFEER } texturing
GEOMETREY PATH hld(}fn surface
w—iﬂ; Unpack Vertices —#  Yertex Operations -—l-.:iem'nmlq Rasrerization | b|ending
4
: : ixels to screen
A foundation for higher level APIs P

Open Inventor; VRML / X3D; Java3D; game engin@GL\Es



What is OpenGL ES?

OpenGL is just too big for Embedded
Systems with limited resources

memory footprint, floating point HW

Create a new, compact API

mostly a subset of OpenGL

that can still do almost all OpenGL can

QroonGLES



OpenGL ES 1.0 design %;
targets .

Preserve OpenGL structure

Eliminate un-needed functionality
redundant / expensive / unused

Keep it compact and efficient
<= 50KB footprint possible, without HW FPU

Enable innovation
allow extensions, harmonize them

Align with other mobile 3D APIs (M3G / JSR-184)

CroenGLES




Adoption QZ

Symbian OS, S60

Brew

PS3 / Cell architecture

Sony’s arguments: Why ES over OpenGL

* OpenGL drivers contain many features not needed
by game developers

« ES designed primarily for interactive 3D app devs

e Smaller memory footprint
QroonGLES




Outline ﬁ

* Background: OpenGL & OpenGL ES

* OpenGL ES 1.0

* OpenGLES 1.1

* EGL: the glue between OS and OpenGL ES

* How can | get it and learn more?

CoenGLES



Functionality: in / out? (1/7) ﬁ§

Convenience functionality is OUT

GLU gluOrtho2D(0,1,0,1) .

.y . VS.
(utility library) a10rtho(0,1,0,1,-1,1 ’IH
evaluators = \
(for splines) SRS
feedback mode

(tell what would draw without drawing) | =xas i

gINewList(1, GL_COMPILE)
selection mode myFuncThatCal 1sOpenGL()
(for picking, easily emulated)

| glEndList()
display lists glcallList(1)

(collecting and preprocessing commands)
CroonGLES




Functionality: in / out? (2/7)

Remove old complex functionality
glBegin — glEnd (OUT); vertex arrays (IN)

new: coordinates can be given as bytes

]:

static const GLbyte verts[4 * 3
{ -1, 1, 1, 1, 1, 1
1, -1, 1, -1, -1, 1 3};
static const GLubyte colors|4 * 3] =
{ 255, 0, O, 255, 0, O
0,255, O, 0,255, O }
glVertexPointer( 3,GL BYTE,O, verts );
glColorPointerf( 3,GL_UNSIGNED BYTE,

O, colors );

glDrawArrays( GL_TRIANGLES, @ -ﬂ ‘




Functionality: in / out? (3/7) E§

Simplify rendering modes

double buffering, RGBA, no front buffer access

Emulating back-end missing functionality Is
expensive or impossible

full fragment processing is IN
alpha / depth / scissor / stencil tests,
multisampling,
dithering, blending, logic ops)

CroenGLES



Functionality: in / out? (4/7) E§

Raster processing

ReadPixels IN, DrawPixels and Bitmap OUT

Rasterization
OUT: PolygonMode, PolygonSmooth, Stipple

CroenGLES



Functionality: in / out? (5/7) &

2D texture maps IN
1D, 3D, cube maps OUT

borders, proxies, priorities, LOD clamps OUT

multitexturing, texture compression IN (optional)
texture filtering (incl. mipmaps) IN "
new: paletted textures IN B




Functionality: in / out? (6/7) &

Almost full OpenGL light model IN

back materials, local viewer,
separate specular OUT oo ww

vie wy2
GL_FPOINTS

Primitives
IN: points, lines, triangles e

GL_LINES

OUT: polygons and quads




Functionality: in / out? (7/7) E§

Vertex processing

IN: transformations

OUT: user clip planes, texcoord generation

Support only static queries

OUT: dynamic queries, attribute stacks

application can usually keep track of its own state

CroenGLES



The great “Floats vs. fixed- %;
point” debate |

Accommodate both

Integers / fixed-point numbers for efficiency

floats for ease-of-use and being future-proof

Detalls

16.16 fixed-point: add a decimal point inside an int

glRotatef( 0.5f, 0.f ,1.f, 0.f )
VS.
glRotatex(1<<15, 0 ,1<<16, 0 );

get rid of doubles

CroenGLES



Outline ﬁ

* Background: OpenGL & OpenGL ES

* OpenGLES 1.0

* OpenGLES 1.1

* EGL: the glue between OS and OpenGL ES

* How can | get it and learn more?

CoenGLES



OpenGL ES 1.1: core

Buffer Objects

allow caching vertex data

Better Textures

>= 2 tex units, combine (+,-,interp), dot3 bumps, auto mipmap gen.

User Clip Planes

portal culling (>=1)

Point Sprites

particles as points not quads, attenuate size with distance

State Queries |
enables state save / restore, good for middleware @GL\ESW



OpenGL ES 1.1: optional

Draw Texture

fast drawing of pixel rectangles using texturing units
(data can be cached), constant Z, scaling

Matrix Palette

vertex skinning (>= 3 matrices / vertex, palette >= 9)

CroonGLES



Outline ﬁ

* Background: OpenGL & OpenGL ES

* OpenGLES 1.0

* OpenGLES 1.1

* EGL: the glue between OS and OpenGL ES

* How can | get it and learn more?

CoenGLES



EGL glues OpenGL ESto OS %3

EGL is the interface between OpenGL ES
and the native platform window system

similar to GLX on X-windows, WGL on Windows

facilitates portability across OS’s (Symbian, Linux, ...)

Division of labor

EGL gets the resources (windows, etc.) and
displays the images created by OpenGL ES

OpenGL ES uses resources for 3D graphic

penGL|ES.



EGL surfaces

=

Various drawing surfaces, rendering targets

windows — on-screen rendering
(“graphics” memory)

pbuffers — off-screen rendering
(user memory)

pixmaps — off-screen rendering
(OS native images)

CroenGLES



EGL context

A rendering context is an abstract OpenGL
ES state machine

stores the state of the graphics engine
can be (re)bound to any matching surface

different contexts can share data
texture objects
vertex buffer objects

lately even across APIs (OpenGL ES, OpenVG)

CrenGLES



Main EGL 1.0 functions %z

Getting started

eglinitialize() / eglTerminate(), eglGetDisplay(),
eglGetConfigs() / eglChooseConfig(),
eglCreateXSurface() (X = Window | Pbuffer | Pixmap),
eglCreateContext()

eglMakeCurrent( display, drawsurf, readsurf,
context )

binds context to current thread, surfaces, display

CrenGLES



Main EGL 1.0 functions %z

eglSwapBuffer( display, surface )

posts the color buffer to a window
eglWaitGL( ), eglWaitNative( engine )

provides synchronization between OpenGL ES
and native (2D) graphics libraries

eglCopyBuffer( display, surface, target )

copy color buffer to a native color pixmap

CrenGLES



EGL 1.1 enhancements %z

Swap interval control

specify # of video frames between buffer swaps
default 1; O = unlocked swaps, >1 save power
Power management events
PM event => all Context lost
Disp & Surf remain, Surf contents unspecified
Render-to-texture [optional]
flexible use of texture memory @GL\ES



Outline ﬁ

* Background: OpenGL & OpenGL ES

* OpenGL ES 1.0 functionality

* OpenGL ES beyond 1.0

* EGL: the glue between OS and OpenGL ES

* How can | get it and learn more?

CrenGLES



SW Implementations

Gerbera from Hybrid

Free for non-commercial use
http://www.hybrid.fi

Vincent
Open-source OpenGL ES librar
P P | Y jlccnﬁ
http://sourceforge.net/projects/ogl-es

Reference implementation

Wraps on top of OpenGL

http://www.khronos.org/opengles/documentation/gles-1.0

penGL|ES.


http://www.hybrid.fi
http://sourceforge.net/projects/ogl-es
http://www.khronos.org/opengles/documentation/gles-1.0c.tgz

On-Device Implementations

NokiaGL (SW)
N93 (HW)
Imagination MBX
NVidia GoForce 3D

ATl Imageon
Toshiba T4G




SDKs

Nokia S60 SDK (Symbian OS)

http://www.forum.nokia.com

Imagination SDK
http://www.pvrdev.com/Pub/MBX

NVIDIA handheld SDK

http://www.nvidia.com/object/hhsdk home.html

Brew SDK & documentation

http://brew.qgualcomm.com



http://www.forum.nokia.com
http://www.pvrdev.com/Pub/MBX
http://www.nvidia.com/object/hhsdk_home.html
http://brew.qualcomm.com

OpenGL ES 1.1 Demos
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Questions?







e

Using OpenGL ES

Jani Vaarala
Nokia



Using OpenGL ES Qi

Simple OpenGL ES example
Fixed point programming

Converting existing code



“Hello OpenGL ES”

560 3rd Edition SDK, for C++ [352x416] - winscw udeb
File Tools Help

| &, Double Resolution Portrait 3521416 + bottom S.K.
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Symbian App Classes ﬁ

DATA

VIEW

Handle Commands (Events, Keys)
Handle Application views




“Hello OpenGL ES”

#include <e32base.h>
#include "SigTriangleGL.h"

GLbyte vertices[3 * 3] =

{
-1, 1, 0,
1, -1, 0,
1, 1, O

}; OpenGL ES




“Hello OpenGL ES”

static const GLubyte colors|[3 * 4] =

{
255, 0, 0, 255 .
0, 255, 0, 255 .
0, 0, 255, 255
};

OpenGL ES ’




“Hello OpenGL ES”

static void InitGLES(Q)

{
glClearColor (O.F,0.F,0.1F,1.P);
glDisable (GL_DEPTH_TEST);
glMatrixMode (GL_PROJECTION) ;
glFrustumf (-1.f,1.f,-1.F,1.F,3.F,1000.71);
gIMatrixMode (GL_MODELVIEW);
glShadeModel (GL_SMOOQOTH) ;
glVertexPointer (3,GL_BYTE,O,vertices);
glColorPointer (4,GL_UNSIGNED BYTE,O,colors);
glEnableClientState (GL VERTEX ARRAY);
glEnableClientState (GL_COLOR_ARRAY);

+

OpenGL ES




“Hello OpenGL ES”

TInt CSigTriangleGL: :DrawCallback( TAny* alnstance )

{
CSigTriangleGL* i1nstance = (CSigTriangleGL*) alnstance;

glClear (GL_COLOR_BUFFER_BIT);
glLoadldentity O;

glTranslatef (0,0,-5.1);
glDrawArrays (GL_TRIANGLES,0,3);

(instance->iEglDisplay, instance->i1EglSurface);

/* To keep the background light on */
1T (1(instance->iFrame%100)) O;

instance->1Frame++;

return O;

OpenGL ES




“Hello OpenGL ES”

void CSigTriangleContainer: :ConstructL(const TRect& /* aRect */)
{

iIGLInitialized = EFalse;

CreateWindowL();
SetExtentToWholeScreen();
ActivateL();

CSigTriangleGL* gl = new (ELeave) CSigTriangleGL( );
gl->Construct(Window());

iIGLInitialized = ETrue;

}

CSigTriangleContainer: :~CSigTriangleContainer()

{
}

Container




“Hello OpenGL ES”

void CSigTriangleContainer: :SizeChanged()

ifGiGLInitialized)

{
glViewport(0,0,Size() -i1Width,Size()-1Height);
¥
¥
void HandleResourceChange( TInt aType )
{
if(aType == KEikDynamicLayoutSwitch)
// Screen resolution changed, make window fullscreen in a new resolution
SetExtentToWholeScreen();
¥
¥
TInt CSigTriangleContainer: :CountComponentControls() const
{
return O;
¥

CCoeControl* CSigTriangleContainer: :ComponentControl (TInt /* alndex */) const

{
}

return NULL;

Container




“Hello OpenGL ES”

/********************** AR I S e

* Initialize OpenGL ES context and initial OpenGL ES state *

AR A T B S S b e e e S S S S e e S S ***********/

void CSigTriangleGL: :Construct(RWindow awin)
{

IWin = aWin;

1IEgIDisplay = (EGL_DEFAULT_DISPLAY);
iT(iEglDisplay == NULL ) User: Exit(-1);

1T( (iEgIDisplay,NULL,NULL) == EGL_FALSE)
User::Exit(-1);

EGLConfig config,colorDepth;
EGLINt numOfConfigs = O;

OpenGL ES




“Hello OpenGL ES”

switch( tWin_.DisplayMode() )

{
case (EColor4K): { colorDepth = 12; break; }
case (EColor64K): { colorDepth = 16; break; }
case (EColori6M): { colorDepth = 24; break; }
default:
colorDepth = 32;
}

EGLInt attrib_list[] = { EGL BUFFER_SIZE, colorDepth,
EGL DEPTH _SI1ZE, 15,
EGL_NONE };

1T( (iEglDisplay,attrib_list,&config,1,
&numOfConfigs ) == EGL_FALSE) User::Exit(-1);

OpenGL ES




“Hello OpenGL ES”

1EglSurface = eglCreateWindowsSurface(iEglDisplay, config, &iWin, NULL );
1T( 1EglSurface == NULL ) User::Exit(-1);

iEglContext = eglCreateContext(iEglDisplay,config, EGL_NO_CONTEXT, NULL );
1T( 1EglContext == NULL ) User::Exit(-1);

1T( egiMakeCurrent( i1EglDisplay, i1EglSurface, i1EglSurface,
iEglContext ) == EGL_FALSE ) User::Exit(-1);

OpenGL ES




“Hello OpenGL ES”

/* Create a periodic timer for display refresh */
iIPeriodic = CPeriodic::NewL( CActive::EPriorityldle );

iIPertodic->Start( 100, 100, TCallBack(
SigTriangleGL: :DrawCal lback, this ) );

INItGLES();

OpenGL ES




Carbide C++ EXxpress %3

Free IDE for S60 development from

Supports 2" edition and 3'd edition SDKs

Here we focus on 3" edition

Future devices will be 39 edition (e.g., N93)


http://www.forum.nokia.com

Importing project

<! Import

Select

Select an import source:

E; Archive file
ﬂ?chedmut Projects from CV5
ﬁExisﬁng Projects into Workspace
[ File system
Elpreferences

[ Symbian Bid.Inf

} Symbian MMF File

i Symbian 05 Executable
%},Team Project Set




Importing project

{ U Bld.Inf
Import Bld.Inf b
Select the Bld.Inf File. sym lan
0s
Source | o:\templegtriangle\group\Bld. Inf | [ Browse l

[]Capy source files into workspace.




Importing project

\ U Bld.Inf

MMP Files Configuration Selection .
Click Finish. Symt"arl
0s
SDKs and Build Configurations
MMP File Name Target Type = IB
EGTriangle.mmp EXE E‘D
= N
- [7] [l 560 3.0 Emulat ’
- [#][3&] 560 3.0 Phone
<
[~
Select emulator configuration
and phone configuration (GCCE)
under S60_3m,
£ 2 £ &
[ Einish H Cancel



Importing .PKG file (for .SIS) Q:

Select from menu: File -> Import

Select “File System”

Navigate to folder “sis” and import .PKG file
“EGTriangle gcce.pkg”

Build will automatically generate install file



Importing .PKG file

\ < Import |§|
File system

=
Import resources from the local file system, U

From directory: |C:‘|,Temp‘|,EGTriangIe‘|sis v| [ Browse... ]

- [#li= 5| EGTriangle_gece. pka

Filter'l_'ypes...] [ Select All ] l Deszelect Al

Into folder: |EGTriangIe | [ Browse...

Options

|:| Cverwrite existing resources without warning
() Create complete folder structure

(%) Create selected folders only

Mext = [ Finish l ’_ Cancel




Compiling & Debugging Qi

Select from menu: Project -> Build ALL

Select from menu: Run -> Debug



Creating debug config

Click “New” to create new
debug config.

¢

\ " Debug

Configurations:

Create, manage, and run configurations

mulation

B Perspectives

These settings assodate a perspective with Symbian OS Emulation launch
configurations. A different perspective may be assodated with each supparted launch
mode, and can optionally be opened when a configuration is launched or when an
application suspends via the Debug preferences. To indicate that a perspective should
niot be opened, select ™Mane”,

Debug: | Debug w |

Run: | Maone bt |

Restore Defaults




Creating debug config

Create, manage, and run configurations

Configurations: Mame: | EGTriangle 560 3.0 Emulator Debug |

= | Symbian OS Emulation
Lo | EGTriangle 560 3.0f =

= main !(x]= Arguments | P Environment | %% Debugger | ¢ %86 Exceptions | B Source || EEsii
Project:

|EGTriangIE |[ Browse... ]
Executable:

| C:/Symbianf9. 1/560_3rd/epoc32 release AWINSCW JUDEB [EGTriangle | lSeardl Project... ] [ Browse... ]

Emulator or host application:
| C:\5ymbian'g, 1'560_3rd'epoc32release \WINSCWUDEE \epoc.exe | [ Browse... ]

£ ! | Eall

[ Mew ] [_ Delete ]

Debug l [ Close




Selecting application %:

When emulator starts, navigate to “Installat.”
folder

Select application to launch (EGTriangle)



Application

S 1560 3rd Edition SDK, for C++ [352x416] - winscw udeb

E_ Double Resolufjon Portrait 352x416 + bottom S.K.

/'

Click this button to cycle
through resolutions and
check that your application
works in all resolutions.

|

B
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Getting it to HW %i

Go to menu: Window -> Open Perspective ->
Other

Select “Symbian (default)”

Go to menu: Window -> Show view -> Build
Configurations



Selecting build configuration

n Build Configurations - EGTriangle X

O o 0t
Click this button to open a
list of possible build
configurations. Select
“*S60 3.0 Phone (GCCE)

Release”




Installation file %z

Build the project (CTRL-B)

Installation file is generated during build

Select it from C/C++ Projects view
EGTriangle GCCE.sis

From context menu select “copy”

Paste it to desktop and send using bluetooth



Fixed point programming @1

Why to use it?

Most mobile handsets don’t have a FPU

Where does it make sense to use it?
Where it makes the most difference
For per-vertex processing: morphing, skinning, etc.

Per vertex data shouldn’t be floating point

OpenGL ES API supports 32-bit FP numbers



Fixed point programming @1

There are many variants of fixed point:
Signed / Unsigned

2's complement vs. Separate sign
OpenGL ES uses 2's complement
Numbers in the range of [ -32768, 32768 |
16 bits for decimal bits (precision of 1/65536)

All the examples here use .16 fixed point



Fixed point programming @3

Examples:

0x0001 0000 = “1.0F”

0x0002 0000 = “2.0F”

0x0010 0000 = “16.0F”

0x0000 0001 = 1/0x10000(0x10000 = 216)

Oxffff ffff = -1/0x10000(-0x0000 0001)



Fixed point programming ﬁ

64-bit
Intermedlate overflow Result overflow
e Higher accuracy (64-bit)  Redo range analysis
* Downscale input » Detect overflow, clamp
 Redo range analysis




Fixed point programming @3

Convert from floating point to fixed point
#define float _to fixed(a) ((nt)((a)*(1<16))

Convert from fixed point to floating point

#define Tixed to float(a) (((float)a)/(1<16))

Addition
#define add_fixed Fixed(a,b) ((a)+(b))

Multiply fixed point number with integer
#define mul_fixed_int(a,b) ((@)*(b))



Fixed point programming

MUL two FP numbers together
#define mul_fixed fixed(a,b) (((A)*(b)) >> 16)

If another multiplier is in]-1.0, 1.0 [, no overflow
Division of integer by integer to a fixed point result
#define div_int_int(a,b) (((a)*(1<<16))/(b))
Division of fixed point by integer to a fixed point result
#define div_fixed_int(a,b) ((a)/(b))
Division of fixed point by fixed point
#define div_fixed fixed(a,b) (((2)*(1<<16))7(b))



Fixed point programming

Power of two MUL & DIV can be done with shifts
Fixed point calculations overflow easily
Careful analysis of the range requirements is required

Always try to use as low bit ranges as possible
32x8 MUL is faster than 32x32 MUL (some ARM)

Using unnecessary “extra bits” slows execution

Always add debugging code to your fixed point math



Fixed point programming

#1T defined(DEBUG)

int add_fix_fix_chk(int a, Int b)

{
Int64 bigresult = ((int64)a) + ((int64)b);
int smallresult = a + b;
assert(smallresult == bigresult);
return smallresult;

ks
#endi T

#1T defined(DEBUG)

# define add fix fix(a,b) add fix Ffix _chk(a,b)
#else

# define add _fix fix(a,b) ((a)+(b))

#endi T



Fixed point programming

Complex math functions

Pre-calculate for the range of interest

An example: Sin & Cos
Sin table between [ 0, 90° ]
Fixed point angle
Generate other angles and Cos from the table
Store as fixed point ( (short) ( sin(angle) * 32767 ) )

Performance vs. space tradeoff: calculate for all angles



Fixed point programming

Sin
90 ° = 2048 (our angle scale)

Sin table needs to include 0° and 90°

INLINE fp_sin(int angle)

{

angle & (2048 + 4096);
angle & 2047;

Int phase
Int subang

1T( phase == 0 ) return sin_table (subang);
else 1T( phase == 2048 ) return sin_table (2048 - subang);
else 1T( phase == 4096 ) return —sin_table (subang);
else return —sin_table (2048 — subang);



Example: Morphing

Simple fixed point morphing loop (16-bit data, 16-bit coeff )

void MorphGeometry(TIntl6 *aOut, const TIntl6 *alnA, const TIntl6

{

*alnB, TInt aCount, TInt aScale)
int 1;

for(1=0; i1<aCount; 1++)

{
aOut[1*3+0] = DOMORPH_16(alnB[1*3+0], alnA[1*3+0], aScale);
aOut[1*3+1] = DOMORPH_16(alnB[1*3+1], alnA[1*3+1], aScale);
aOut[1*3+2] = DOMORPH_16(alnB[1*3+2], alnA[1*3+2], aScale);
}



Converting existing code %i

OS/device conversions

Programming model, C/C++, compiler, CPU

Windowing API conversion
EGL API Iis mostly cross platform

EGL Native types are platform specific

OpenGL -> OpenGL ES conversion




Example: Symbian porting

Programming model
C++ with some changes (e.g., exceptions)
Event based programming (MVC), no main / main loop

Three level multitasking: Process, Thread, Active Objects

ARM CPU

Unalighed memory accesses will cause exception



Example: EGL porting

Native types are OS specific
EGLNativeWindowType (RWindow)
EGLNativePixmapType (CFbsBitmap)
Pbuffers are portable

Config selection

Select the color depth to be same as in the display

Windowing system issues
What if render window is clipped by a system dialog?

Only full screen windows may be supported




OpenGL porting

- gIBegin/glEnd wrappers
- _gIBegin stores the primitive type
- _glColor changes the current per-vertex data
- _glVertex stores the current data behind arrays and increments
- _glEnd calls glDrawArrays with primitive type and length

_glBegin(GL_TRIANGLES) ;
_9glColor4f¥(1.0,0.0,0.0,1.0);
_glVertex3f(1.0,0.0,0.0);
_glVertex3f(0.0,1.0,0.0);

_glEndQ);




OpenGL porting Qi

Display list wrapper

Add the display list functions as wrappers
Add all relevant GL functions as wrappers

When drawing a list, go through the collected list



OpenGL porting

void _glEnable( parl, par2 )

{

1T( GLOBAL()->1SubmittingDisplayList )

{
*(GLOBAL()->dlist)++ = DLIST_CMD_GLENABLE;
*(GLOBAL() -—>dlist)++ = (GLuint)parl;
*(GLOBAL() -—>dlist)++ = (GLuint)par?2;

}

else

{
glEnable(parl,par2);

}

}



OpenGL porting %3

Vertex arrays

OpenGL ES supports only vertex arrays

SW implementations get penalty from float data
Use as small types as possible (byte, short)

For HW it shouldn’t make a difference, mem BW

With OpenGL ES 1.1 use VBOs



OpenGL porting

No quads

Convert a quad into 2 triangles

No real two-sided lighting

If you really need it, submit front and back triangles

OpenGL ES and guerying state
OpenGL ES 1.0 only supports static getters
OpenGL ES 1.1 supports dynamic getters

For OpenGL ES 1.0, create own state tracking if needed



Questions?

2D
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Building scalable 3D applications

Ville Miettinen

Hybrid Graphics



What Is this
"mobile platform”?

CPU speed and available memory varies
Current range ~30Mhz - 600MHz, no FPUs

Portablility issues
Different CPUs, OSes, Java VMs, C compilers, ...

Different resolutions

QCIF (176x144) to VGA (640x480), antialiasing on higher-
end devices

Color depths 4-8 bits per channel (12-32 bpp)



Graphics capabilities

General-purpose multimedia hardware
Pure software renderers (all done using CPU & integer ALU)
Software + DSP / WMMX / FPU / VFPU
Multimedia accelerators

Dedicated 3D hardware

Software T&L + HW tri setup / rasterization
Full HW

Performance: 50K — 2M tris, 1M — 100M pixels



Dealing with diversity @z

Problem: running the same game on 100+ different
devices

Same gameplay but can scale video and audio

Scalability must be built into game design

Profile-based approach



3D content Is easy to scale

Separate low and high poly 3D models
Different texture resolutions & compressed formats

Scaling down special effects not critical to game
play (particle systems, shadows)

Important to realize what is a "special effect”

Rendering quality controls

Texture filtering, perspective correction, blend functions,
multi-texturing, antialiasing



Building scalable 3D apps

OpenGL ES created to standardize the API and
behavior

ES does not attempt to standardize performance
Two out of three ain’t bad

Differences between SW/HW configurations
Trade-off between flexibility and performance

Synchronization issues



Building scalable 3D apps

Scale upwards, not downwards
Bad experiences of retro-fitting HW titles to SW
Test during development on lowest-end platform

Both programmers and artists need education

Artists can deal with almost anything as long as they know
the rules...

And when they don't, just force them (automatic checking in
art pipeline)



Reducing state changes

Don’t mix 2D and 3D calls !l

Situation may become better in the future, though...

Unnecessary state changes root of all evil
Avoid changes affecting the vertex pipeline
Avoid changes to the pixel pipeline

Avoid changing textures



"Shaders”

Combine state changes into blocks ("shaders”)
Minimize number of shaders per frame
Typical application needs only 3-10 "pixel shaders”
Different 3-10 shaders in every application
Enforce this in artists’ tool chain
Sort objects by shaders every frame

Split objects based on shaders



Complexity of shaders

Software rendering: Important to keep shaders as
simple as possible

Do even if introduces additional state changes

Example: turn off fog & depth buffering when rendering
overlays

Hardware rendering: Usually more important to
keep number of changes small



Of models and stripping

Use buffer objects of ES 1.1

Only models changed manually every frame
need vertex pointers

Many LOD schemes can be done just by
changing index buffers

Keep data formats short and simple

Better cache coherence, less memory used



Triangle data

Minimize number of rendering calls
Trade-off between no. of render calls & culling efficiency
Combine strips using degenerate triangles
Understanding vertex caching

Automatically optimize vertex access order

Triangle lists better than their reputation
Optimize data in your art pipeline (exporters)
Welding vertices with same attributes (with tolerance)
Vertices/triangle ratio in good data 0.7-1.0

Give artists as much automatic feedback as possible



Transformations and
maitrices

Minimize matrix changes
Changing a matrix may involve many hidden costs
Combine simple objects with same transformation

Flatten and cache transformation hierarchies

ES 1.1: Skinning using matrix palettes
CPU doesn’t have to touch vertex data

Characters, natural motion: grass, trees, waves

ES 1.1: Point sprites



Lighting and materials

Fixed-function lighting pipelines are so 1990s
Drivers implemented badly even in desktop space
In practice only single directional light fast
OpenGL’s attenuation model difficult to use
Spot cutoff and specular model cause aliasing

No secondary specular color



Lighting: the fast way

While we’re waiting for OpenGL ES 2.0...
Pre-computed vertex illumination good if slow T&L
lllumination using texturing

Light mapping
ES 1.1: dot3 bump mapping + texture combine

Less tessellation required
Color material tracking for changing materials

Flat shading is for flat models!



lllumination using
multitexturing
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Textures

Mipmaps always a Good Thing™
Improved cache coherence and visual quality

ES 1.1 supports auto mipmap generation
Different strategies for texture filtering
SW: Perspective correction not always needed

Avoid modifying texture data
Keep textures "right size”, use compressed textures



Textures

Multitexturing
Needed for texture-based lighting
Always faster than doing multiple rendering passes
ES 1.1: support at least two texturing units

ES 1.1: TexEnvCombine neat toy

Combine multiple textures into single larger one

Reduce texture state changes (for fonts, animations, light
maps)



Textures and shots from Kesmai’'s Air Warrior 4 (never published)




Object ordering

Sort objects into optimal rendering order
Minimize shader changes
Keep objects in front-to-back order
Improves Z-buffering efficiency

Satisfying both goals: bucketize objects by shader, sort
buckets by Z



Thank you! ﬁ:

Any questions?







M3G Overview

Tomi Aarnio

Nokia Research Center




Objectives %

Get an idea of the API structure and feature set

Learn practical tricks not found in the spec



Prerequisites Qi

Fundamentals of 3D graphics

Some knowledge of OpenGL ES

Some knowledge of scene graphs



Mobile 3D Graphics APIs ﬁ

Java Applications

M2E (JSR:184)

Native C/C++
Applications

OPENGIEES

Graphics Hardware




Why Should You Use Java?

It has the largest and fastest-growing installed base

1.2B Java phones had been sold by June 2006 (source: ovum)
Nokia alone had sold 350M Java phones by the end of 2005

Less than 50M of those also supported native S60 applications

It increases productivity compared to C/C++

Memory protection, type safety = fewer bugs

Fewer bugs, object orientation =» better productivity



Java Will Remain Slower

1.0

0 Assembly |
O KVM |
@ Jazelle™ |
B HotSpot

Relative speed
o
o1

0.0
Vertex transformation Image downsampling

Benchmarked on an ARM926EJ-S processor with hand-optimized Java and assembly code



Why?

Array bounds checking )
Dynamic type checking

No stack allocation (heap only)
No Java compiler or
accelerator can fully
resolve these issues

Garbage collection
Slow Java-native interface
No access to special CPU features

Stack-based (non-RISC) bytecode

Unpredictable JIT compilers Y,



M3G Overview

Design principles
Getting started
Basic features
Performance tips
Deforming meshes
Keyframe animation

Summary & demos




M3G Design Principles

NerJavercederalonalcrtical pags

* Move all graphics processing to native code
— Not only rasterization and transformations
— Also morphing, skinning, and keyframe animation

— Keep all data on the native side to avoid Java-native traffic



M3G Design Principles

Cater or Peth Seitweare and narcweare

* Do not add features that are too heavy for software engines

— Such as per-pixel mipmapping or floating-point vertices

* Do not add features that break the OpenGL 1.x pipeline

— Such as hardcoded transparency shaders



M3G Design Principles

Viexiimize develeper proe UctVILY,

* Address content creation and tool chain issues

— EXxport art assets into a compressed file (.m3g)
— Load and manipulate the content at run time

— Need scene graph and animation support for that

* Minimize the amount of “boilerplate code”



M3G Design Principles ﬁ

Minlmiize engine cemplexity.
Minimize firagimentation

Rlanteritittire expansion



Why a New Standard?

OpenGL ES is too low-level
Lots of Java code, function calls needed for simple things
No support for animation and scene management
Fails on Design Principles 1 (performance) and 3 (productivity)

...but may become practical with faster Java virtual machines

Java 3D is too bloated
A hundred times larger (!) than M3G

Still lacks a file format, skinning, etc.

Fails on Design Principles 1, 3, and 4 (code size)
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The Programming Model

Not an “extensible scene graph”
Rather a black box — much like OpenGL
No interfaces, events, or render callbacks

No threads; all methods return only when done

Scene update Is decoupled from rendering
render =» Draws an object or scene, no side-effects
animate = Updates an object or scene to the given time

align =» Aligns scene graph nodes to others



Main Classes

3D graphics context

Graphics3D /‘ Performs all rendering

Loads individual objects

/ and entire scene graphs

(.m3g and .png files)

\Word

-/‘ Scene graph root node



Rendering State

Graphics3D contains global state
Frame buffer, depth buffer
Viewport, depth range
Rendering quality hints

Most rendering state is in the scene graph
Vertex buffers, textures, matrices, materials, ...
Packaged into Java objects, referenced by meshes

Minimizes Java-native data traffic, enables caching



Graphics3D: How To Use

Bind a target to it, render, release the target

void paint(Graphics g) {
try {
myGraphics3D.bindTarget(g);
myGraphics3D.render(world);
} finally {
myGraphics3D.releaseTarget();
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Renderable Objects

2D image placed in 3D space

SpritesD /‘ Always facing the camera

Made of triangles
Base class for meshes



Sprite3D

» 2D image with a position in 3D space
» Scaled mode for billboards, trees, etc.
* Unscaled mode for text labels, icons, etc.

* Not useful for particle effects — too much overhead

ImagezD

=00



Mesh

* A common VertexBuffer, referencing VertexArrays

* IndexBuffers (submeshes) and Appearances match 1:1

m \VertexBuiier

INCEXBUITEN

VertexArrays

CooKdinates

normals

00)[0)fs

ApPPEAIANCE teExcoords




VertexBuffer Types ﬁf

Byte |Short|Fixed|Float| 2D | 3D | 4D

Vertices x X | x X
Texcoords x X X
Normals X X
Colors X X

Relative to OpenGL ES 1.1




IndexBuffer Types

3
Byte | Short % Strip | Fan | List
Triangles X x
Lines X X x X X
Points X X x X
Point sprites X X X X

Relative to OpenGL ES 1.1 + point sprite extension



Buffer Objects

Vertices and indices are stored on server side

Very similar to OpenGL Buffer Objects

Allows caching and preprocessing (e.g., bounding volumes)

Tradeoff — Dynamic updates have some overhead
At the minimum, just copying in the Java array contents

In the worst case, may trigger vertex preprocessing



Appearance Components

ComposinglVieee

PolygenRviede

=00

hextuezZb

/1
/
/
/
/

Material colors for lighting
Can track per-vertex colors

Blending, depth buffering
Alpha testing, color masking

Winding, culling, shading
Perspective correction hint

Fades colors based on distance
Linear and exponential mode

Texture matrix, blending, filtering
Multitexturing: One Texture2D for each unit



The Fragment Pipeline

Colored
Fragment Texture2D

ihexture
Blend

\
1
|
I

I

I

Trexture [Depth Erame
Blenad BUlier BUlier




The Scene Graph




Node Transformations

* From this node to the parent node

* Composed of four parts
— Translation T
— Orientation R

— Non-uniform scale S

— Generic 3x4 matrix M

* Composite:C=TRSM




Other Node Features

Automatic alignment
Aligns the node’s Z and/or Y axes towards a target

Recomputes the orientation component (R)

Inherited properties
Alpha factor (for fading in/out)
Rendering enable (on/off)

Picking enable (on/off)

Scope mask



The File Format

Characteristics
Individual objects, entire scene graphs, anything in between
Object types match 1:1 with those in the API
Optional ZLIB compression of selected sections
Can be decoded in one pass — no forward references
Can reference external files or URIs (e.g. textures)

Strong error checking
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Retained Mode

Use the retained mode
Do not render objects separately — place them in a World
Minimizes the amount of Java code and method calls

Allows the implementation to do view frustum culling, etc.

Keep Node properties simple
Favor the T R S components over M
Avoid non-uniform scales in S

Avoid using the alpha factor



Rendering Order

Use layers to impose a rendering order
Appearance contains a layer index (an integer)
Defines a global ordering for submeshes & sprites
Can simplify shader state for backgrounds, overlays

Also enables multipass rendering in retained mode

Optimize the rendering order
Shader state sorting done by the implementation

Use layers to force back-to-front ordering



Textures

Use multitexturing to save in T&L and triangle setup
Use mipmapping to save in memory bandwidth
Combine small textures into texture atlases

Use the perspective correction hint (where needed)
Usually much faster than increasing triangle count

Nokia: 2% fixed overhead, 20% in the worst case



Meshes

Minimize the number of objects
Per-mesh overhead is high, per-submesh also fairly high
Lots of small meshes and sprites to render =» bad
Ideally, everything would be in one big triangle strip

But then view frustum culling doesn’t work =» bad

Strike a balance
Merge simple meshes that are close to each other

Criteria for “simple” and “close” will vary by device



Shading State

Software vs. hardware implementations
SW: Minimize per-pixel operations
HW: Minimize shading state changes

HW: Do not mix 2D and 3D rendering

In general, OpenGL ES performance tips apply



Particle Effects

Several problems
Point sprites are not supported

Sprite3D has too much overhead

Put all particles in one Mesh

Use additive
alpha blend and

One particle == two triangles
per-vertex colors

All glued into one triangle strip /
Update vertices to animate Triangle strip Particles glued into
starts here one tri-strip using

XYZ, RGBA, maybe UV degenerate triangles



Terrain Rendering

Easy terrain rendering
Split the terrain into tiles (Meshes)
Put the meshes into a scene graph

The engine will do view frustum culling

Terrain rendering with LOD
Preprocess the terrain into a quadtree
Quadtree leaf node == Mesh object
Quadtree inner node == Group object

Enable nodes yourself, based on the view frustum
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Deforming Meshes

/| Vertex morphing mesh
Vieiphingviesh
Skeletally animated mesh
SkinnedViesh /I Y



MorphingMesh

Traditional vertex morphing animation

Can morph any vertex attribute(s)
A base mesh B and any number of morph targets T,

Result = weighted sum of morph deltas

R=B+) w(T,-B)

Change the weights w; to animate



MorphingMesh

Target 1 Target 2 Animate eyes
eyes closed mouth closed and mouth
iIndependently



SkinnedMesh

Articulated characters without cracks at joints
Stretch a mesh over a hierarchic “skeleton”

The skeleton consists of scene graph nodes
Each node (“bone”) defines a transformation

Each vertex is linked to one or more bones
v'=> w,M,Bv
i

M, are the node transforms — v, w, B are constant



SkinnedMesh

! a !
shared vertex, ! | non-shared

weights = (0.5, 0.5) . s /| vertex

Neuirall pese, BeRES at est




SkinnedMesh

position in A's
coordinate system

s interpolated

e " position
2 =
[ P Bone A _a 5

position in B's
- coordinate system

Bone B rotatea 90 deagrees



SkinnedMesh

No skinning Smooth skinning
two bones per vertex
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Animation Classes

Anlimateniirack

0)9)|eiE)D)

d

d

Storage for keyframes

KeyframeSegquence /‘ Defines interpolation mode

Controls the playback of

ARimationcontieller /‘ one or more sequences

A link between sequence,
controller and target

Base class for all objects
that can be animated




Animation Classes

|dentifies

---------------=» gnimated
. property on

' this object

Anlmatienilirack

ma ANimationController

ma KEViAMESEGUENCE



KeyframeSequence

Keyframe is a time and the value of a property at that time
KeyirameSeqUence
Can store any number of keyframes

Several keyframe interpolation modes

Can be open or closed (looping)

[ . ——— -

N

[ —— .

- — —

sequence time

Diagram courtesy of Sean Ellis, Superscape



KeyframeSequence

Keyframe is a time and the value of a property at that time
KeyirameSeqUence
Can store any number of keyframes

Several keyframe interpolation modes

Can be open or closed (looping)

sequence time

Diagram courtesy of Sean Ellis, Superscape



KeyframeSequence

Keyframe is a time and the value of a property at that time
KeyirameSeqUence
Can store any number of keyframes

Several keyframe interpolation modes

Can be open or closed (looping)

t sequence time

Diagram courtesy of Sean Ellis, Superscape



AnimationController

. - Can control several animation sequences together
ARimauenConielEr |
Defines a linear mapping from world time to sequence time

Multiple controllers can target the same property

0 seqguence time d

T =

A

»
»

t world time

Diagram courtesy of Sean Ellis, Superscape



Animation

1. Call animate(worldTime)

4. Apply value to
animated property

0) bJ eci2D ........................

Anlmatienilirack

2. Calculate sequence
time from world time

ma ANimationController

e KEVirameSeguence

0 sequence time d

N e

S

3. Look up value at
this sequence time

Diagram courtesy of Sean Ellis, Superscape



Animation

Interpolate quaternions as ordinary 4-vectors
Supported in the latest M3G Exporter from HI Corp
SLERP and SQUAD are slower, but need less keyframes

Quaternions are automatically normalized before use
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Predictions

Resolutions will grow rapidly from 128x128 to VGA

Drives graphics hardware into all high-resolution devices

Software rasterizers can’'t compete above 128x128

Bottlenecks will shift to Physics and Al

Bottlenecks today: Rasterization and any Java code
Graphics hardware will take care of geometry and rasterization

Java hardware will increase performance to within 50% of C/C++

Java will reinforce its position as the dominant platform



Summary

* M3G enables real-time 3D on mobile Java
— By minimizing the amount of Java code along critical paths

— Designed for both software and hardware implementations

* Flexible design leaves the developer in control
— Subset of OpenGL ES features at the foundation

— Animation & scene graph features layered on top

IRstallied base grewing kY the milliens each month




Demos



Playman Winter Games —
Mr. Goodliving

playman’
91.01m




Playman World Soccer —
Mr. Goodliving

":..ISERJ'EE 60 SCREENSHOTS

* An interesting
2D/3D hybrid

* Cartoon-like 2D
characters set ”ﬂm-

In a 3D scene

» 2D overlays for
particle effects
and status info

> |peRRiER L




Tower Bloxx — Sumea

Luxury Tower
Challenze: 100 population

Puzzle/arcade
mixture

Tower building
mode is in 3D, with
2D overlays and
backgrounds

City building mode
IS In pure 2D




Mini Golf Castles — Sumea

* 3D with 2D
background
and overlays

» Skinning
used for
characters

» Realistic ball
physics
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Q&A

Thanks: Sean Ellis, Kimmo Roimela,
Nokia M3G team, JSR-184 Expert Group,
Mr. Goodliving (RealNetworks),
Sumea (Digital Chocolate)






Using M3G

Mark Callow
Chief Architect

"HI CORPORATION




Agenda QZ

Game Development Process

Asset Creation

Program Development

MIDlet Structure

A MIDlet Example

Challenges in Mobile Game Development

Publishing Your Content



M3G Game Demo

Copyright 2005, Digital Chocolate Inc.



Game Development Process

Traditional Java Game
Game logic Compile> Java MIDlet l Package> JAR file

Assets
Images || Sounds || Music Other

/

Game Platform

2D Graphics

[

Sound || Network

Proprietary

Diagram courtesy of Sean Ellis, ARM. Ot h er
Screen Image: Boulder Dash®-M.E. ™




M3G Development Process

How M3G Fits

Expande_d Compile> Java MIDlet l Package> JAR file
game logic

Assets
Images || Sounds || Music || 3D World

/

Game Platform

2D Graphics

Sound || Network

Proprietary

Diagram courtesy of Sean Ellis, ARM. 3 D G I’ap h | CS

Screen Image: Sega/Wow Entertainment RealTennis.™




Asset Creation

* Textures & Backgrounds
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Asset Creation

Audio Tools
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Asset Creation

* Music Tools

MIDIFSEQUENCETN; €. J.

sSielnberg Cukhase

Formats:
oSMAE MIDIF eMIBIFEMEI




Asset Creation
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Export 3d Model to M3G
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M3G File Viewer

[File size 831423 byte

OomposmngMode Io_[1:
-Fog ID_[171]
- Polygontaode ID_[ 258 ]
Material ID_[ 24 ]
B Camera ID_[ 81 ]
Bl AnimationTrack_10_[10 ]
- BnimationController I0_[ 5 ]
- KevframeSequence
E| AnimationTrack_ID_[11 ]

- AnimationContraller I0_[ 6 ]
- KevframeSequence

- Backeround ID_[13 ]
B Camera 1D [81]

E| AnimationTrack_ID_[10]

i BnimationContraller ID_[ & ]
kewframeSequence
E| AnimationTrack_ID_[11 ]

L BnimationGontraller ID_[6 ]
- KevframeSequence

Mode g H 4 I
Light Mode
I AMEIENT | ‘
Light Intenzity
r 1.000
Light Caolor
0xF7EFES

— Light Attenuation
Constant  |[1.000
Linear  [0.000
Cluadratic lD.DDD

—Spot Light Stuff
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Tips for Designers 1

TIP: Don’t use GIF files

The specification does not require their support

TIP: Create the best possible quality audio & music

It's much easier to reduce the quality later than increase it

TIP: Polygon reduction tools & polygon counters
are your friends

Use the minimum number of polygons that conveys your
vision satisfactorily



Tips for Designers 2

TIP: Use light maps for lighting effects
Usually faster than per-vertex lighting
Use luminance textures, not RGB

Multitexturing is your friend

TIP: Try LINEAR interpolation for Quaternions
Faster than SLERP

But less smooth



Tips for Designers 3

TIP: Use background images
Can be scaled, tiled and scrolled very flexibly

Generally much faster than sky boxes or similar

TIP: Use sprites as impostors & labels
Generally faster than textured quads

Unscaled mode is (much) faster than scaled

LIMITATION: Sprites are not useful for particle
systems
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Program Development

* Edit, Co ' ge
< Expande_OI Compile> Java MIDlet Package> JAR file
game logic L

T raditional

o Wik, shell, editer, make, [avac

Integrated Development Envirenment

s Eclipse

e Borland JBuilder

o SuniJava Studio




Program Development

Test & Debug

Carrier/Maker supplied SDK Game Platform
sEmulator 2D Graphics

[

«Simulator Sound || Network

*Real device Proprietary
3D Graphics

Screen Image: Sega/Wow Entertainment RealTennis.™
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The Simplest MIDlet

Derived from MIDlet,
Overrides three methods

ANQ

MIDlet.StartApp()

[initialize]

Create canvas; load

world.

[request redraw]

y

MIDlet.destroyApp()

[shut down]

Canvas.paint()

Tidy up; exit MIDlet.

that’s It.

performs rendering
using Graphics3D
object.



A More Interesting MIDlet

MIDlet.StartApp()

initialize

Create canvas; load

Update loop.
Runnable.run() <

Read user input,
update scene

\

Y

world, start update
thread

user input

Get any user input via
Canvas.commandListener

A 4

scene update

Game logic, animate,
align if necessary

A 4

Exit request

Flow-chart courtesy of Sean Ellis, Superscape

| request

| MG S »  draw

: redraw

\ il _ Canvas.paint()

! : Wait to ensure _

! wait consistent performs rendering
: frame rate USing GraphiCSBD
E object

i MIDlet.destroyA

-+ shut down yAPP(

Tidy up; exit MIDlet




MIDlet Phases ﬁ

Initialize

Update
Draw

Shutdown



Initialize %

Load assets: world, other 3D objects, sounds, etc.
Find any objects that are frequently used

Perform game logic initialization

Initialize display

Initialize timers to drive main update loop



Update %Z

Usually a thread driven by timer events

Get user input

Get current time

Run game logic based on user input

Game logic updates world objects if necessary
Animate

Request redraw



Update Tips Qi

TIP: Don’t create or release objects If possible

TIP: Call system.gc() regularly to avoid long
pauses

TIP: cache any value that does not change every
frame; compute only what is absolutely necessary



Draw

Usually on overridden paint method
Bind Graphics3D to screen
Render 3D world or objects

Release Graphics3D

...whatever happens!
Perform any other drawing (Ul, score, etc)

Request next timed update



Draw Tips ﬁ

TIP: Don’t do 2D drawing while Graphics3D is
bound




Shutdown @2

Tidy up all unused objects

Ensure once again that Graphics3D is released

Exit cleanly

Graphics3D should also be released during
pauseApp



MIDlet Review

Set up display, load

initialize

assets, find commonly

used objects, initiate

Update loop.

Don’t create/destroy
objects if possible

Throttle to consistent <
frame rate

Keep paint() as simple
as possible

Be careful with threads

\

Y

update thread.

user input

Get any user input,
network play, etc.

A 4

scene update

Game logic,
animate, align if

A 4

necessary

Exit request

Diagram courtesy of Sean Ellis, Superscape

i request | I draw

: redraw

i * Wait to ensure Graphics3D obje_ct
! wait consistent performs rendering
i frame rate

i Release assets,

-+ shut down

tidy up
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Demo: UsingM3G MIDlet ﬁ




UsingM3G MIDlet @3

Displays Mesh, MorphingMesh and SkinnedMesh

Loads data from .m3g files
View can be changed with arrow keys
Animation can be stopped and started

Animation of individual meshes can be stopped
and started.

Displays frames per second.



UsingM3G Framework

import java.io.l0Exception;
import javax.microedition.lcdui.*;
import javax.microedition.midlet._™;

public class Cans extends MIDlet implements CommandListener {
Command cmdExit = new Command("Exit", Command.SCREEN, 1);
Command cmdPlayPause = new Command("'Ctrl",Command.SCREEN,1);
private TargetCanvas tcanvas = null;

Thread renderingT = null;

private String Filename = "/coffee.m3g";

public void startApp() {
IT (tcanvas == null)
initQ;

renderingT = new Thread(tcanvas);
renderingT.start();
tcanvas.startPlay();



UsingM3G Framework

public void pauseApp() {
iIT (tcanvas.isPlaying)
tcanvas.pausePlay();

renderingT = null;

}

public void destroyApp(boolean u) {

pauseApp()
tcanvas = null;

}




UsingM3G Framework

synchronized public void commandAction(Command c,
Displayable d)
{

{
notifyDestroyed();

return;
} else {
iIT (tcanvas.isPlaying)
tcanvas.pausePlay();
else
tcanvas.startPlay();
+

}



UsingM3G Initialization

// From class Cans
public void Init() {
Display disp = Display.getDisplay(this);

1T (tcanvas.hasException)
notifyDestroyed();
tcanvas.setCommandListener(this);
tcanvas.addCommand(cmdEXit) ;
tcanvas.addCommand(cmdP layPause) ;
disp.setCurrent(tcanvas);



UsingM3G Initialization

class TargetCanvas extends Canvas i1mplements Runnable
.. // 1nstance variable declarations elided
public TargetCanvas(String m3gFile)

{
try
. _
fileName = m3gFile;
g3d = Graphics3D.getlnstance();
w = getWidth();
h = getHeight();
¥ _
catch(10Exception e)
{

System.out.printin('loading fails:"+fFileName);
hasException = true;

}
}



Loading the 3D data

// class TargetCanvas
void Load() throws 10Exception {
loadObjs = Loader.load(fileName);
iIf (loadObjs==null)
throw new RuntimeException(*'M3G file error™);

/* find the world node */

for (int 1=0; i1<loadObjs.length; ++1) {
iIT (loadObjs|1] instanceof World) {
gWorld = (World)loadObjs[1i1];
hasWorld = true;
break;

}
}

1T (ThasWorld)
throw new RuntimeException(
"World node not found; iIncorrect m3g file?*);



Loading the 3D Data (Cont.) &

meshController =
(AnimationController)gWorld.find(meshControllerlid);

morphingMeshController =
(AnimationController)gWorld.find(morphingMeshControll

erld);
skinnedMeshController =
(AnimationController)gWorld. find(skinnedMeshControlle

rid);

/* Clean up after the loading process. */
System.gc(Q);

}



TargetCanvas run method

public void run(Q)

{
for(G;) {
long start, elapsed;
start = System.currentTimeMillis();
handlelnput();
repaint(); // Request paint()
elapsed = System.currentTimeMillis() - start;
// 1t (want to measure true frame rate)
// Unfriendly to system!!
//renderTime += (int)elapsed;
// else {
renderTime += (elapsed < 50) ? 50 : (int)elapsed;
try {
IT (elapsed < 50) Thread.sleep(650-elapsed);
} catch (InterruptedException e) { }
//}



TargetCanvas paint method

synchronized protected void paint(Graphics g)

{
iIT (loadObjs == null) return;
g.setClip(0, 0, w, h);
try

{

g3d.setViewport(O0, 0, w, h);
render();

}

g.-setColor (OXfffffff);
g.drawString(""fps: " + fps, 2, 2, g.-TOP|g.LEFT);

}



TargetCanvas render
method

void render()

{
iIT (isPlaying) {
frameCount++;
fps = (Int) ((1000*frameCount) / renderTime) ;
/* update the scene */
gWorld.animate((int)renderTime);

3
g3d.render(gWorld);
3



Camera Manipulation

/**
* A camera manipulator. This class applies rotations to
* a World’s activeCamera that make 1t rotate around the
* prime axes passing through the World®"s origin.

*/

public class CameraManip

1
public CameraManip(World world) { }
public void buildCameraXform() { }

public void
baseRotate(float dAngleX, float dAngleY, float dAnglez){ }

public void
rotate(float dAngleX, float dAngleY, float dAngleZ) { }

public void setCameraXform(Q) { }




Initializing CameraManip

public CameraManip(World world) {
Transform world2Cam = new Transform();
float[] matrix = new float[16];
/* .. class variable 1nitialization elided */

curCamera = world.getActiveCamera();
iIT (curCamera = null) {
curCamera.getTransftormTo( world, world2Cam );
world2Cam.get( matrix );
distToTarget = (float)Math.sqgrt( matrix[3]*matrix[3]
+ matrix[7]*matrix[7]
+ matrix[1ll]*matrix[11l] );

curCamera.getTransform( curOriginalXform );
rotate( 0, 0, 0 );
world2Cam = null;
+
+



Rotating the Camera

public void rotate(float dAngleX, float dAngleY,
float dAngleZ) {
iIf (curCamera == null) return;

baseRotate( dAngleX, dAngleY, dAngleZ );
Transform rotTrans = new Transform();

rotTrans.postRotate( angleY, O, 1, 0 );
rotTrans.postRotate( angleX, 1, 0, 0 );

float pos|[] = { 0, O, distToTarget, 1 };
rotTrans.transform( pos );

dx = pos[O0];
dy = pos[1];
dz = pos[2] - distlToTarget;

bui IldCameraXform() ;
setCameraXform();
rotTrans = null;



Building the Camera
Transform

public void buildCameraXform() {
cameraxXxform.setldentity();
rotatexXform.setldentity();
transXform.setldentity();

transXform.postTranslate( dx, dy, dz );

// rotate about the x-axis then the y-axis
rotateXform.postRotate( angleY, 0, 1, 0 );
rotateXform.postRotate( angleX, 1, 0, 0 );

cameraxXform.postMultiply( transXform );
cameraxXform.postMultiply( rotatexXform );

}

public void setCameraXform() {
cameraxXform.postMultiply( curOriginalXform );
curCamera.setTransform( cameraxXxform );

}
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Why Mobile Game
Development is Difficult

Application size severely limited
Download size limits

Small Heap memory

Small screen
Poor input devices
Poor quality sound

Slow system bus and memory system



Why Mobile Game %;
Development is Difficult |
No floating point hardware

No integer divide hardware

Many tasks other than application itself
Incoming calls or mail

Other applications
Short development period
Tight budget, typically $100k — 250k



Memory

Problems

Small application/download size

Small heap memory size

Solutions
Compress data D
Use single large file D
Use separately downloadable levels M
Limit contents @

Get makers to increase memory @



Performance

Problems

Slow system bus & memory

No integer divide hardware

Solutions
Use smaller textures @
Use mipmapping M
Use byte or short coordinates and key values @

Use shifts @
Let the compiler do it @



User-Friendly Operation

Problems

Button layouts differ

Diagonal input may be impossible

Multiple simultaneous button presses not recognized
Solutions

Plan carefully

Different difficulty levels

Same features on multiple buttons

Key customize feature



Many Other Tasks

Problem
Incoming calls or mail

Other applications

Solution

Create library for each handset terminal
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Publishing Your Content %i

Can try setting up own site but
it will be difficult for customers to find you
Impossible to get paid
may be impossible to install MIDlets from own site

Must use a carrier approved publisher

Publishers often run own download sites but
always with link from carrier's game menu.

As with books, publishers help with distribution
and marketing



Publishing Your Content

Typical end-user cost is $2 - $5.
Sometimes a subscription model is used.
Carrier provides billing services

Carriers in Japan take around 6%

Carriers in Europe have been known to demand as much as
40%! They drive away content providers.

In some cases, only carrier approved games can be
downloaded to phones

Enforced by handsets that only download applets OTA
Developers must have their handsets modified by the carrier



Publishers @2

Find a publisher and build a good relationship with
them

Japan: Square Enix, Bandai Networks, Sega WOW,
Namco, Infocom, etc.

America: Bandai America, Digital Chocolate, EA
Mobile, MForma, Sorrent

Europe: Digital Chocolate, Superscape,
Macrospace, Upstart Games



Other 3D Java Mobile APIs

Mascot Capsule Micro3D Family APIs
Motorola IDEN, Sony Ericsson, Sprint, etc.)

com.mascotcapsule.micro3d.v3
Vodafone KK JSCL

com.j_phone.amuse.j3d , com.jblend.graphics.j3d
Vodafone Global

com.vodafone.amuse.j3d

NTT Docomo (DoJa)

com.nttdocomo.opt.ui.j3d (DoJa2, DoJa 3)

com.nttdocomo.ui.graphics3D (DoJa 4)




Mascot Capsule V3 Game
Demo

]B\( RINT

% DELUXE ‘E@Wﬂow W

Copyrlght 2005 bylnteractlve Bralns Co Ltd.



Summary @3

Use standard tools to create assets
Basic M3G MiIDlet is relatively easy
Programming 3D Games for mobile is hard

Need good relations with carriers and publishers to
get your content distributed



Exporters

3ds max Cinema 4D
— Simple built-in exporter since 7.0 — www.c4d2m3g.com
— www.diqgi-element.com/Export184/ o * Site appears to be defunct

— www.mascotcapsule.com/M3G/ " Lightwave

®
— Www.ma3gexporter.com — www.mascotcapsule.com/M3G/ @M

Maya « Blender

— www.mascotcapsule.com/M3G/

— http://www.nelson-games.de/bl2m3q/

— www.m3gexport.com

Softimage| XSl .

— www.mascotcapsule.com/M3G/ "



http://www.digi-element.com/Export184/
http://www.mascotcapsule.com/M3G/
http://www.m3gexporter.com
http://www.mascotcapsule.com/M3G/
http://www.m3gexport.com
http://www.mascotcapsule.com/M3G/
http://www.c4d2m3g.com
http://www.mascotcapsule.com/M3G/
http://www.nelson-games.de/bl2m3g/

SDKs

Motorola IDEN J2ME SDK

— idenphones.motorola.com/iden/developer/developer_tools.jsp

Nokia Series 40, Series 60 & J2ME

— www.forum.nokia.com/java

Sony Ericsson

— developer.sonyericsson.com/java

Sprint Wireless Toolkit for Java

— developer.sprintpcs.com

Sun Wireless Toolkit

— Java.sun.com/products/j2Zmewtoolkit/download-2_2.html



http://www.forum.nokia.com/java

* VFX SDK (Vodafone Global)

— via.vodafone.com/vodafone/via/lHome.do

* VFX & WTKforJSCL (Vodafone KK)

— developers.vodafone.jp/dp/tool dl/java/emu.php




IDE’'s for Java Mobile

* Eclipse Open Source IDE

— www.eclipse.org

* JBuilder 2005 Developer

— www.borland.com/ijbuilder/developer/index.html

* Sun Java Studio Mobility

— www.sun.com/software/products/ismobility

* Comparison of IDE’s for J2ME

— www.microjava.com/articles/J2ME IDE Comparison.pdf



http://www.eclipse.org
http://www.borland.com/jbuilder/developer/index.html
http://www.sun.com/software/products/jsmobility
http://www.microjava.com/articles/J2ME_IDE_Comparison.pdf

Other Tools

Macromedia Fireworks

— www.adobe.com/products/fireworks/

* Adobe Photoshop

— www.adobe.com/products/photoshop/main.html

*  Sony SoundForge

— www.sonymediasoftware.com/products/showproduct.asp?PID=961

* Steinberg Cubase

— www.steinberg.de/33 1.html

* Yamaha SMAF Tools

— smaf-yamaha.com/



http://www.adobe.com/products/fireworks/
http://www.adobe.com/products/photoshop/main.html
http://www.sonymediasoftware.com/products/showproduct.asp?PID=961
http://www.steinberg.de/33_1.html
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Thanks: HI Mascot Capsule Version 4
Development Team, Koichi Hatakeyama,
Sean Ellis, JSR-184 Expert Group






Closing & Summary ﬁ

We have covered
OpenGL ES
M3G




KHRCSNOS API palette

G RO

The Khronos API family provides a complete ROYALTY-FREE,
cross-platform media acceleration platform
\

1
Applications or middleware libraries (JSR 184 engines, Flash players, media players etc.)
N SElaTS @— enMAX aL
CpenSLIES. bk Fz
= ayback an .
( )' - Platform Media
D enGL\ES.. penVG. {ﬁ&‘#g'c';% Frameworks
Small foo:t;pIZnt 3D for .Xﬁ.ﬁ\t,gf,eft?r s'-?."""fe"’e? COpenMAX L Component interfaces
embedded systems acceleration API gaming aqdlo —Pen B for codec integration
accekgftlon
EGL Image Libraries,_Videp Codecs,
Absgg ﬁe d Access to Sound Libraries
esources
: C\ Accelerated media
£ mlr)é%g?:; “r \)penMAX"DL primitives for codec
development
Media Engines — CPUs, DSP, Hardware Accelerators etc.
\

Khronos defines low-level, FOUNDATION-level APIs.
“Close to the hardware” abstraction provides portability AND flexibility




CC JLLADA

An open interchange format

to exchange data between
content tools

allows mixing and
matching tools for
the same project

allows using desktop
tools for mobile content



Shaders? Yes! Qi

OpenGL ES 2.0

subset of OpenGL 2.0, with very similar shading
language

spec draft at SIGGRAPH 05, conformance tests
summer 06, devices 08 (?)

M3G 2.0
adds shaders and more to M3G 1.1

first Expert Group meeting June 06



2D Vector Graphics

OpenVG

low-level API, HW acceleration

spec draft at SIGGRAPH 05, conformance tests summer 06

JSR 226: 2D vector graphics for Java
SVG-Tiny compatible features
completed Mar 05

JSR 287: 2D vector graphics for Java 2.0

rich media (audio, video) support, streaming

work just starting



EGL evolution @1

It’s not trivial to efficiently combine use of
various multimedia APIs in a single
application

EGL is evolving towards simultaneous
support of several APIs

OpenGL ES and OpenVG now

a

Khronos APIs later



Summary @3

Fixed functionality mobile 3D is reality NOW

these APIs and devices are out there

go get them, start developing!
Better content with Collada
Solid roadmap to programmable 3D

Standards for 2D vector graphics






